Operational Insight

R362.1

Installation Guide
## Contents

### Chapter 1: Introduction
- System Requirements ................................................................. 1
- Software Requirements ................................................................. 1
- Hardware Requirements ............................................................... 4
- Operational Insight Help .............................................................. 5
- Conventions Used in This Book ..................................................... 5
- Honeywell Product Support ......................................................... 6

### Chapter 2: Installing Operational Insight
- Pre-installation ........................................................................... 9
- Disable the Windows Updates ..................................................... 9
- Enable ASP .NET 3.5 feature ..................................................... 10
- OIUser and Password Complexity ............................................. 10
- CalcEngine User and Password Complexity ............................ 10
- Installation ................................................................................. 11
- Custom Installation .................................................................. 13
- Installing From a Network Location .......................................... 13
- Post-Installation ....................................................................... 15
- Setting the Java Runtime Parameter ....................................... 16
- Post-installation steps for java 1.8 ........................................... 16
- Configuring Operational Insight Components .......................... 16
- Using a Secure Server ............................................................. 21
- Configuring Additional IIS Settings ........................................ 23
- Updating the OIUser Settings .................................................. 23
- Adding Global Variable ............................................................ 24
- Disabling Java Certificate Check ............................................. 25
- Configuration changes for Trend with Event feature ............... 25
- Launching ProcessNet for Integrated login ............................. 26
- Configuring Trend with Events while running OI on a non default port ................................................................. 26
- Error: Could not commit the join position[0] ........................... 26
- Configure Netoffice ................................................................. 27
- Configure IE settings for Netoffice .......................................... 28
- Netmanage configuration on client ........................................ 28

### Chapter 3: Upgrading From Previous Versions of Operational Insight
- Pre-upgrade: Firebird ............................................................... 29
- Pre-upgrade: Processes and Services ........................................ 29
- Upgrade ................................................................................... 30
- Custom Upgrade ..................................................................... 34

### Chapter 4: Un-installing Operational Insight
- Configure DataTransferTool .................................................. 36
- Configure DataTransferTool .................................................. 36

### Chapter 5: Licensing Operational Insight
- Systems With Internet Access ................................................ 40
- Systems Without Internet Access .......................................... 41
Chapter 1: Introduction

System Requirements

See the following sections for the system requirements:

• **Software Requirements**
• **Hardware Requirements**

The following system requirements are listed based on the installed components:

• Web Server: An install of the Operational Insight Web Server and databases.
• Web Client: A computer that remotely accesses the Operational Insight Web Server, but does not have a local of the Operational Insight install.
• NetManage Only: An install of the NetManage component on a computer separate from the Operational Insight Web Server.
• Operational Insight R362.1 does not support native drivers. Connections to any historian must be through OPC interface.
• If you are upgrading to Operational insight R362.1 from the previous version, where Native drivers are used to connect to the third party historians, then you must change the Datasource to point to the corresponding OPC server. All the existing Operational Insight pages should be modified to point to OPC server and OPC tags.

Refer to "Tag information update tool" to automatically change the tags from Native format to OPC format in Operational Insight component pages (NetDraw, NetTrend, NetCalc, NetEvnet, NetChart).

**Software Requirements**

<table>
<thead>
<tr>
<th>Legend</th>
<th>Required, included</th>
</tr>
</thead>
<tbody>
<tr>
<td>![checkmark]</td>
<td>(will be installed by the installation wizard)</td>
</tr>
<tr>
<td>![checkmark]</td>
<td>Supported version, not included</td>
</tr>
</tbody>
</table>

| ![x] | Not Supported |
## Supported and Required Software

<table>
<thead>
<tr>
<th>Operating Systems</th>
<th>WEB SERVER</th>
<th>WEB CLIENT</th>
<th>NETMANAGE ONLY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012 Standard</td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
</tr>
<tr>
<td>Windows Server 2012 R2</td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
</tr>
<tr>
<td>Windows Server 2008 Standard Edition R2 SP1 x64</td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
</tr>
<tr>
<td>Windows 8 Pro/Enterprise (x64)</td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
</tr>
<tr>
<td>Windows 8.1 Pro/Enterprise (x64)</td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
</tr>
<tr>
<td>Windows 7 SP1 x86</td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
</tr>
<tr>
<td>Windows 7 SP1 x64</td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
<td><img src="check.png" alt="Check" /></td>
</tr>
</tbody>
</table>

### Databases

- **For Operational Insight:**
  - Firebird 2.5.3
    - ![Check](check.png)

- **Only for the NetObjects component:**
  - Microsoft SQL Server 2014 Express/ Standard Edition (x64)
    - ![Check](check.png)

- **Only for the NetObjects component:**
  - Microsoft SQL Server 2012 Express/ Standard Edition (x64)
    - ![Check](check.png)

- **Only for the NetObjects component:**
  - Microsoft SQL Server 2008 R2 SP2 x86
    - ![Check](check.png)

- **Only for the NetObjects component:**
  - Microsoft SQL Server 2008 R2 SP2 x64
    - ![Check](check.png)

- **Only for the NetObjects component:**
  - Microsoft SQL Server 2005 SP4 x86
    - ![Check](check.png)
### Browsers

<table>
<thead>
<tr>
<th>Browser</th>
<th>WEB SERVER</th>
<th>WEB CLIENT</th>
<th>NETMANAGE ONLY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer 8.0 x86 (JavaScript must be enabled)</td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
</tr>
<tr>
<td>Microsoft Internet Explorer 9.0 x86 (JavaScript must be enabled)</td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
</tr>
<tr>
<td>Microsoft Internet Explorer 10.0 x86 (Only Compatibility mode is supported)</td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
</tr>
<tr>
<td>Microsoft Internet Explorer 11.0 x86 (Only Compatibility mode is supported)</td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
</tr>
<tr>
<td>Microsoft Internet Explorer Metro Mode</td>
<td><img src="#" alt="X" /></td>
<td><img src="#" alt="X" /></td>
<td><img src="#" alt="X" /></td>
</tr>
</tbody>
</table>

### Additional Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>WEB SERVER</th>
<th>WEB CLIENT</th>
<th>NETMANAGE ONLY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Information Services (IIS) Version dependant on operating system: 7.5 or 8.0 or 8.5</td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
</tr>
<tr>
<td>Sun Java Virtual Machine 1.8u51</td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
</tr>
<tr>
<td>Microsoft .NET Framework 3.5 SP1</td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
</tr>
<tr>
<td>Microsoft ASP.NET AJAX 1.0</td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
</tr>
<tr>
<td>Microsoft Data Access Components (MDAC) 2.8</td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
</tr>
<tr>
<td>Microsoft C++ 2005 Service Pack 1 Redistributable</td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
<td><img src="#" alt="Checkmark" /></td>
</tr>
</tbody>
</table>

### Optional Software
## Hardware Requirements

<table>
<thead>
<tr>
<th></th>
<th>WEB SERVER</th>
<th>WEB CLIENT</th>
<th>NETMANAGE ONLY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>3GHz</td>
<td>3 GHz</td>
<td>550 MHz</td>
</tr>
<tr>
<td>RAM</td>
<td>4 GB</td>
<td>2 GB</td>
<td>256 MB</td>
</tr>
<tr>
<td>HDD</td>
<td>1 GB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Conventions Used in This Book

This book uses the following conventions.

### Conventions Used

<table>
<thead>
<tr>
<th>Convention</th>
<th>Used To</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Highlight items that belong to the interface, such as buttons, menus, check boxes, and so on.</td>
</tr>
<tr>
<td><strong>Italic</strong></td>
<td>Highlight book titles and items that require emphasis.</td>
</tr>
<tr>
<td><strong>Courier</strong></td>
<td>Highlight filenames, functions, code examples, or text that a user must type as input.</td>
</tr>
<tr>
<td><strong>LOW CAPS</strong></td>
<td>Highlight keys to be pressed on the keyboard.</td>
</tr>
</tbody>
</table>

In addition to the conventions above, you will also find **Note**, **FMI**, **Tip**, and **Caution** messages throughout the manual. These messages contain valuable information that is important for you to read and understand. Although this book may not contain all message types, you may encounter one or more of the four types:

**Note**

Directs your attention to information on memory limitations, specific configurations, or operating systems.

**FMI**

*(For More Information)* Directs you to additional resources.

**Tip**

Suggests an alternative method but is not essential to use the product.

**Caution**

Informs you of possible data loss or program failure and provides preventative actions.
Honeywell Product Support

Honeywell's Product Support Specialists are trained service professionals committed to providing the highest quality technical support. Honeywell's Product Support service provides the following:

• Help with product issues involving operation and functionality.
• Problem isolation and identification.
• Problem resolution and workarounds.
• Error message analysis and resolution.
• Up-to-date information on current releases, product compatibility, restrictions, enhancements, and fixes.
• Unlimited access to Honeywell's online Product Knowledge Base.
# Contacting Us

## Customer Care Center Listing

### North America

- **Canada and United States**
  - Phone: 800-622-7673
  - Phone: 602-293-1966

- **Email**: askssc@Honeywell.com

### Middle East and South Africa

- **Bahrain** - Phone: 8008 1343
- **Oman** - Phone: 8007 7595
- **Qatar** - Phone: 800 5460
- **Saudi Arabia** - Phone: 800 844 5309
- **South Africa** - Phone: 0800 963 634
- **Turkey** - Phone: 00800 449823557
- **United Arab Emirates** - Phone: 8000 444 0300

- **Email**: HPSCustomerSupport@honeywell.com

### Europe

- **Austria** - Phone: 0800 000643
- **Belgium** - Phone: 0800 485 80
- **Bulgaria** - Phone: 700 20771
- **Croatia** - Phone: 0800 60 6392
- **Czech Republic** - Phone: 800 142 784
- **Denmark** - Phone: 8025 21 85
- **Finland** - Phone: 0800 915 938
- **France** - Phone: 0805 10 00 41
- **Germany** - Phone: 0800 7239098
- **Greece** - Phone: 08000 13 9493
- **Hungary** - Phone: 06 800 20 699
- **Ireland** - Phone: 1800 939 488
- **Italy** - Phone: 8000 35205
- **Israel** - Phone: 1 809 407 309
- **Luxembourg** - Phone: 8002 8524
- **Netherlands** - Phone: 0800 0203498
- **Norway** - Phone: 800 11 478
- **Poland** - Phone: 00 800 121 50 46
- **Portugal** - Phone: 800 855 944
- **Romania** - Phone: 0 800 800 178
- **Russia Federation** - Phone: 8 10 80 02-412 50 11
- **Slovakia** - Phone: 0800 002 340
- **Spain** - Phone: 800 099 804
- **Sweden** - Phone: 020 088 3187
- **Switzerland** - Phone: 0800 080 035
- **United Kingdom** - Phone: 0800 279 7226

### Asia Pacific

- **Coming Soon!**
Chapter 1: Introduction

Advanced Solutions TAC

North America
Canada and United States - askssc@Honeywell.com
Phone: 800-822-7673
Phone: 602-293-1866

EMEA
Phone: 32 2 728 2200

Asia Pacific
Australia - GTAC@honeywell.com
Phone: 1300-300-4822 (toll free within Australia)
+61-8-9362-9559 (outside Australia)

India - Global-TAC-India@honeywell.com
Phone: +91-20- 66039400

Korea - Global-TAC-Korea@honeywell.com
Phone: +82-2-799-6317
+82-11-9227-6324

China - Global-TAC-China@honeywell.com
Phone: +86-21-52574568

Singapore - GTAC-SEA@honeywell.com
Phone: +65-6580-3500

Taiwan - Global-TAC-Taiwan@honeywell.com
Phone: +886-7-536 2567

Japan - Global-TAC-Japan JA25@honeywell.com
Phone: +81-3-5730-7160
Chapter 2: Installing Operational Insight

Before installing Operational Insight, ensure that you know the required arrangement of all the components.

Pre-installation

Disable the Windows Updates

Before installing Operational Insight, do all of the following:
1. Ensure there are no Windows Updates pending, and that no restart is required in the Windows taskbar.
2. On the Windows Start menu, point to Settings, point to Control Panel, point to Administrative Tools, and then click Services.
   The Services control panel appears.
3. It is recommended that you temporarily disable any antivirus software on the system prior to beginning the installation, as it can cause the installation to fail on some systems.

Install .Net 3.5 on Windows 2012, Windows 2012 R2, Windows 8, and Windows 8.1

Follow the instructions given below to complete the .Net Framework 3.5 installation on Windows 2012. Ensure that you have the Windows 2012 media before you follow the instructions given below.
1. Insert the Windows Server DVD.
2. Click Start > Server Manager.
   The Server Manager window appears.
3. On the Manage menu, click Add Roles and Features.
4. Select .Net Framework 3.5 Features, expand and select Non-http Activation, and then click Next.
5. In the Confirm installation selections screen, select the Specify an alternate source path link.
6. Choose the path of the DVD drive, and then click OK.
7. Click Install, and follow the on-screen prompts.
Enable ASP .NET 3.5 feature

By default, the OI installer installs IIS. If you have already installed IIS separately on the machine where you are installing OI, ensure that you have enabled the ASP .NET 3.5 feature.

To enable ASP .NET 3.5 feature:
1. Click Start > Server Manager. The Server Manager window appears.
2. Click Add Roles and Features.
3. On the left pane, select Server Selection.
4. On the left pane, select Server Roles.

OIUser and Password Complexity

Operational Insight creates a windows user to be used by the IIS application pool. By default, the user is created with the following settings:

- User Name: OIUser
- Password: Avatar@01

If the default password does not meet your password complexity requirements, the OIUser must be created manually prior to installing Operational Insight:

- On the server, create a user with the name OIUser, and with a password that meets your complexity requirements. (Refer to your Windows documentation for instructions on creating a user.)

Note

Once the installation is complete, refer to the post-installation section "Updating the OIUser Settings" on page 23 for additional configuration steps required for the manually-created OIUser.

CalcEngine User and Password Complexity

For CalcEngine installation, if the password complexity is different on the machine on which OI is being installed, then perform the following steps.

1. Open Command Prompt.
2. Change the directory to CalcEngine.msi directory.
3. Run the following command:
   
   msiexec.exe /i CalcEngine.msi CESPASSWORD=<password>
   
   Where <password> can be a password of your choice.
   
   For example, msiexec.exe /i CalcEngine.msi CESPASSWORD="Pass*045CalcEn1"
Installation

Note
If you are installing from a network location, refer to “Installing From a Network Location” on page 13 before beginning the installation. We recommend installing Operational Insight from the installation media, or by copying the installation files to the local system.

To install Operational Insight R362.1

1. For an installation of standard components, ensure SQL Server is installed, and an instance has been created for See “To install select components” on page 13 use with NetObjects. If NetObjects is not required, you do not need an instance of SQL Server. for instructions on installing without NetObjects.
2. Right-click the setup.exe file and select Run as Administrator. The setup wizard appears.

Select Feature
Select the feature you would like to install.

Typical Install (Honeywell Operational Insight)
Selected this option to install the most common components on a single computer.

Honeywell NetOffice Setup
Selected this option to install Honeywell NetOffice on a client machine. Honeywell NetOffice will provide the ability to create real-time MS Excel reports based on live data from any of your data sources.

Honeywell NetManage Setup
Selected this option to install the Honeywell NetManage utility on a client machine. Honeywell NetManage has the ability to connect to the Prometheus server from a remote machine, allowing manipulation of key properties and functionality.

Custom
Select this option to perform a custom installation of Honeywell Operational Insight.

Next > Close

Operational Insight setup wizard

3. Select the installation option that matches the computer for which you are installing the required components, and then click Next. For example, to select a complete installation of all standard components on the server computer, select Typical Install. To install the NetManage client only, select Honeywell NetManage Setup.

Note
If you are restarting an interrupted installation, the Typical Install option is not available. Select Custom Install to continue the previous installation.

4. Follow the remaining steps in the Installation Wizard, and click Install to begin the installation.
Chapter 2: Installing Operational Insight

5 When prompted for the license, enter the license information as described in “Licensing Operational Insight” on page 41.

6 When the NetObjects Setup opens, provide the required NetObjects credentials:
   a On the SQL Server Connection page, do all of the following:
      i Select Set SQL Server connection details.
      ii Type the following in the related boxes:
         • SQL Server Name: the name of the SQL Server instance to be used with NetObjects.
         • Database Name: the name of the database in which to store the NetObjects data. By default, this is NetObjects.
         • SA Name: the name of the system administrator account for the database instance. By default, this is sa.
         • SA Password: the password for the system administrator account on the database instance.
      iii Click Next.
   b On the NetObjects User Credentials page, do all of the following:
      i Assign a password to the following NetObjects accounts in the related boxes:
         • NOAdmin: this account is used by NetObjects Administrator accounts to connect to the NetObjects data source.
         • NOQuery: this account is used by all other NetObjects accounts to connect to the NetObjects data source.
      ii Click Next.
   c On the Ready to Modify the Application page, click Next.
   d Click Finish to close the NetObjects Setup.
   The Password Manager tool is displayed. New passwords must be entered for all the Users listed in the tool.
   For more information on how to use this tool, refer to the “Password Manager Tool User Guide” provided in the Operational Insight R362.1 media.

7 Click OK in the installation complete dialog box to close the Installation Wizard.

8 Refer to “Post-Installation” on page 15 for additional configuration settings that may need to be completed.
Custom Installation

Operational Insight R362.1 now includes the NetObjects (which requires SQL Server) component by default. If you do not require NetObjects or any other additional components, you can use the Custom option to install only selected components.

To install select components

1. Right-click the setup.exe file and select Run as Administrator
   The setup wizard appears.

2. Select Custom and then click Next.
3. Follow the remaining steps in the Installation Wizard until the installation file list is displayed.
4. Click Advanced.
   The Component List appears.
5. Clear the check box for any unneeded components, and then click OK.
   For example, clear the Honeywell NetObjects check box if NetObjects is not required on this server.
6. Complete the installation as normal.

Installing From a Network Location

We recommend installing from the installation media, or by copying the installation files to the local system.

If you are installing Operational Insight from a network location, the .NET Framework’s trust level setting must be set to Full Trust.

Perform the steps in “To grant full trust to the URL of a network share” on page 14 if the following conditions apply:

• .NET is already installed on the system (for example, if you are upgrading from a previous version of Operational Insight).
To grant full trust to the URL of a network share

1. On the local computer, on the Windows Start menu, point to Settings, point to Control Panel, point to Administrative Tools, and then click Microsoft .NET Framework 2.0 Configuration. The .NET Configuration appears.

2. On the tree, under My Computer, expand Runtime Security Policy, aright-click All_Code, and then select New. The Create Code Group wizard appears.

3. Do all of the following:
   a. In the Name box, type a name for the code group (for example, Operational Insight Remote Access).
   b. (Optional) In the Description box, type a description of the code group.
   c. Click Next. The condition type page appears.

4. Do all of the following:
   a. From the condition type list, select URL.
   b. In the URL box, type the UNC URL of the mapped network share (the location of the installation media) using the following structure:
      \[remote_machine_name]\[share_directory_name]\*
      For example:
      \[RemoteComputer\OperationalInsightInstall\]*
      Note
      The end of the URL needs the (*) wildcard notation. This encompasses all the files and folders in the directory on the remote computer.
   c. Click Next. The permissions page appears.

5. Do all of the following:
   a. Select Use existing permission set.
   b. From the list select FullTrust.
   c. Click Next. The complete wizard page appears.

6. Click Finish.

7. Do all of the following to reset IIS:
   b. Type cmd and click OK. The Command Console appears.
   c. Type iisreset, and press ENTER.

8. Delete the temporary ASP.NET files from the following location: C:\WINDOWS\Microsoft.NET\Framework\2.0\ Temporary ASP.NET Files
Post-Installation

When you access OI from the client you will get a Java security warning while accessing various Operational Insight components as shown below. To avoid this security warning, click the Do not show this again for this app and web site check box, and then click Allow. You will not receive this warning if OI is installed on the same machine.

![Security Warning]

Note
Oracle doesn’t recommend having multiple versions of JREs on the system. Hence it is recommended to have only one version of JRE and uninstall the rest. For more details, refer to the link https://java.com/en/download/faq/remove_oldversions.xml.

Post - Installation Steps
This section contains the following post-installation steps:

- Setting the Java Runtime Parameter
- Post-installation steps for java 1.8
- Configuring Operational Insight Components
- Using a Secure Server
- Configuring Additional IIS Settings
- Updating the OIUser Settings
- Adding Global Variable
- Disabling Java Certificate Check
- Configuration changes for Trend with Event feature
- Verify IE Settings
- Launching ProcessNet for Integrated login
- Configuring Trend with Events while running OI on a non default port
- Configure Netoffice
- Configure IE settings for Netoffice
- Netmanage configuration on client
Chapter 2: Installing Operational Insight

Setting the Java Runtime Parameter

Follow the steps given below only if you are using Windows 8/8.1. Alternatively, you can open the Command Prompt window from the following location:

C:\Windows\SysWOW64\cmd.exe, and then run the ConfigureJRE.vbs file, which is present in the Matrikon folder in the media/CD.

1. Open Control Panel.
2. Double-click Java Plug-in.
3. Click the Java tab.
4. Click View.
5. In the Java Runtime Parameters text box, type -Dsun.java2d.noddraw=true or -Dsun.java2d.d3d=false.
6. Click OK.

Post-installation steps for java 1.8

In Java 1.8 update 20 onwards, the Medium security level has been removed. Now only High and Very High levels are available. For more details refer to the Java 1.8 update 20 release notes: http://www.oracle.com/technetwork/java/javase/8u20-relnotes-2257729.html

If you are not able to run Operational Insight after JRE has expired then add the website to the exception site list.

Adding websites to Java exception site list

1. Go to Java control panel.
2. Select security tab.
3. Click on Edit Site List.
4. Enter the location as http://<hostname>/ProcessNet.
5. Click Ok and close the control panel.

Configuring Operational Insight Components

The Operational Insight Components NetSchedule and NetEvent will require some setting changes before they can be used. Your Operational Insight administrator will be required to do the following tasks.

NetSchedule

To prepare NetSchedule, perform the following tasks:

1. To configure NetSchedule
2. To authorize the Java settings
Note
Ensure that JRE is upgraded on the server to the latest one. Having a lower version of JRE may block NetSchedule reports. For more information on how to upgrade JRE refer to the steps given in “Post-installation steps for java 1.8”.

To configure NetSchedule

1. To provide NetSchedule with a local administrator user name and password, do all of the following:
   a. In the DataServer folder, double-click the NSPasswordChanger.exe utility. The NetSchedule Application Manager opens.
      By default, this utility is installed in the following location: C:\Program Files\Matrikon\ProcessSuite\ProcessNet\DataServer

   ![NetSchedule Application Manager](image)

2. Do all of the following:
   a. Type the new user name in the **UserName** box.
   b. Type the new password in the **Password** box.
   c. Type the new password again in the **Confirm** box.
   d. Click **OK**.
Chapter 2: Installing Operational Insight

3. If required, do all of the following to change the From address in NetSchedule.ini:
   a. On the NetManage Options menu, click INI Manager.
   
   ![INI Manager interface]

   b. Select and expand the node for NetSchedule.ini. The file categories for NetSchedule.ini appear.
   c. Select MISC. The MISC properties appear in the right pane.
   
   ![NetSchedule.ini—MISC properties]

   d. Enter the new e-mail address in the FromAddress box. The change is saved automatically.
To authorize the Java settings

1. Open Operational Insight on the server computer using the NetSchedule user provided to the **NetSchedule Application Manager** (see “To configure NetSchedule” on page 17, step one).
   A Java Security Information prompt appears.

   ![Java security warning](image)

   **Java security warning**

   2. Select *Always trust content from the publisher*, and then click **Run**.
   3. Restart the server computer.

NetEvent

To prepare NetEvent, perform the following task:

- **To configure NetEvents**

To configure NetEvents

1. On the NetManage **Options** menu, click **INI Manager**.

   ![INI Manager interface](image)

   **INI Manager interface**

   2. To set the e-mail server and port number, do all of the following:
      a. Select and expand the node for **NetOutput.ini**.
         The file categories for **NetOutput.ini** appear.
Chapter 2: Installing Operational Insight

b Select E-mail.
The E-mail properties appear in the right pane.

NetOutput.ini—E-mail properties

c Do any of the following that apply:
• Enter the e-mail port in the Port box.
• Enter the e-mail server in the Server box.
The changes are saved automatically.

3 If required, do all of the following to change the From address in NetEvent.ini: as described in “To change the NetEvent From e-mail address” on page 196 of the Operational Insight Administrator’s Guide.

a Select and expand the node for NetEvent.ini.
The file categories for NetEvent.ini appear.
b Select E-mail.
The E-mail properties appear in the right pane.

NetEvent.ini—E-mail properties

c Enter the new e-mail address in the From box.
The change is saved automatically.
Using a Secure Server

If Operational Insight is installed on a server that is configured to use SSL/HTTPS, the following settings need to be configured on the server to ensure Operational Insight and its components work as intended:

1. Encrypted Page Handling
2. Updating NetSchedule
3. Updating Configuration Files

Encrypted Page Handling

To change the Internet encrypted page handling

1. On the server computer, open Internet Explorer.
2. On the Tools menu, select Internet Options. The Internet Options page appears.
3. Select the Advanced tab, and then in the Security section clear the Do not save encrypted pages to disk check box.
4. Click OK to close the Internet Options dialog box, and then close Internet Explorer.
5. Restart the Internet Information Services (IIS) service.

Updating NetSchedule

The NetSchedule Trend Template location must be updated through NetManage to use SSL.

To update the NetSchedule settings

1. On the NetManage Options menu, click INI Manager.
3. Select MISC. The MISC properties appear in the right pane.
NetSchedule.ini—MISC properties

4. Update the location in the TrendTemplate box to use https:// instead. The new value should read


The change is saved automatically.

Updating Configuration Files

To use the NetTrend display event markers feature when the server is configured to use Integrated Logins, SSL, or both, the appropriate configuration files must be used by the system.

To replace the default configuration files

1. Navigate to the following folder location:
   \Matrikon\ProcessSuite\ProcessNet\DataServer

2. Do all of the following:
   a. Create a backup copy of the NetManage.exe.Config file.
   b. Delete the NetManage.exe.Config file.
   c. Rename one of the following to NetManage.exe.Config, based on your system settings:
      • If you are using Integrated Logins, rename the NetManage_IL.exe.Config file.
      • If you are using a SSL server, rename the NetManage_SSL.exe.config file.
      • If you are using Integrated Logins on an SSL server, rename the NetManage_IL_SSL.exe.config file.

3. Navigate to the following folder location:
   \Matrikon\ProcessSuite\ProcessNet\Web\OIDataService

4. Do all of the following:
   a. Create a backup copy of the Web.config file.
   b. Delete the Web.config file.
c Rename one of the following to Web.config, based on your system settings:
  • If you are using Integrated Logins, rename the Web_IL.config file.
  • If you are using a SSL server, rename the Web_SSL.config file.
  • If you are using Integrated Logins on an SSL server, rename the Web_IL_SSL.config file.

**Configuring Additional IIS Settings**

If you are using Windows Server 2008 R2, once Operational Insight is installed the authPersistSingleRequest setting in IIS must be enabled.

**To enable authPersistSingleRequest**

1. On the Windows Start menu, click All Programs, click Administrative Tools, and then click Server Manager.
   The Server Manager window appears.

   **Tip**
   The Server Manager is pinned to the taskbar by default in Windows 2008 R2. If it has not be unpinned, you can open it by clicking the Server Manager icon in the taskbar.

2. Expand Roles, expand Web Server (IIS), and select Internet Information Services (IIS) Manager.
3. In the IIS Services Manager, expand the node for the computer, expand Sites, and then select ProcessNet.
4. Under Management, select Configuration Editor.
5. Click the Section drop down list, expand system.webServer, expand security, expand authentication, and then select windowsAuthentication.
6. Change the authPersistSingleRequest value to True.

**Updating the OIUser Settings**

If you manually-created the OIUser (see “OIUser and Password Complexity” on page 10), the user must be added to the IIS application pool once the Operational Insight installation is complete.

• Windows Server 2012/2012 R2/2008 R2

Windows Server 2012/2012 R2/2008 R2

**To configure the OIUser**

1. On the Windows Start menu, click All Programs, click Administrative Tools, and then click Internet Information Services (IIS) Manager.
   The Internet Information Services (IIS) Manager window appears.

2. Select Application Pools.
   The Application Pools page appears.
Chapter 2: Installing Operational Insight

3 Click **OperationalInsightAppPool**.
4 In the right-hand sidebar select **Advanced Properties**.
   The **Advanced Settings** dialog box appears.
5 Under the **Process Model** section, select the **Identity** value box, and then click the **Browse** button.
   The **Application Pool Identity** dialog box appears.
6 Select **Custom account**, and then click **Set**.
   The **Set Credentials** dialog box appears.
7 Do all of the following:
   a In the **User name** box, type \OIUser or SystemName\OIUser.
   b In the **Password** box, type the password you created for OIUser.
   c In the **Confirm password** box, type the password you created for OIUser again.
   d Click **OK**.
   OIUser appears in the **Custom account** box.
8 Click **OK** in the **Application Pool Identity** dialog box, and then click **OK** in the **Advanced Settings** dialog box.
9 Right-click **OperationalInsightAppPool**, and then click **Stop**.
10 Right-click **OperationalInsightAppPool**, and then click **Start**.

**Adding Global Variable**

**Note**
Follow the steps mentioned below only if you are seeing the “Session Manager” error frequently while switching between links in Profile tree.

There are two global variables introduced in Honeywell Operational Insight software updates R360.2:

- **ProfileTreeTimeOut** - The value for this variable must be in milliseconds. The Profile tree links works based on the value provided for this variable. When you click a link, the page associated with the link is loaded. Further click on the link is disabled for the duration that is entered in ProfileTreeTimeOut global variable.
- **WebSites** - This global variable can be used to enable or disable the ProfileTreeTimeOut functionality for a particular website. If you are providig multiple website names, separate the website names with a comma (,).

**To add the global variable**

1 Open NetManage.
   The **NetManage** window appears.
2 On left pane, click **Global Variable**.
3 On right pane, select and expand the **General** node.
4 Right click **General**, and then click **Add Variable**.
   The **Add Global Variable** dialog opens.
5 To add the ProfileTreeTimeOut variable, do all of the following:
   a In the **Name** box, type **ProfileTreeTimeOut**.
   b In the **Comment** box, type the comment.
   c In the **Value** box, type the value of the global variable in milli seconds. For instance, type 5000 to configure for 5 seconds.
   d If you want to enter more than one virtual path, you can provide multiple paths separated by a comma. For example: PDWebReports, PGWebGuard.
   e Click **OK**.

6 To add the ProfileTreeTimeOut variable, do all of the following:
   a In the **Name** box, type **WebSites**.
   b In the **Comment** box, type the comment.
   c In the **Value** box, type the value of the global variable. The value must be a valid virtual path name excluding "/". For instance, if virtual path name is "/PDWebReports", type PDWebReports.
   d Click **OK**.

**Disabling Java Certificate Check**

If a client system is not connected to Internet then browsing Operational Insight will be very slow. This is because from Java 1.7 update 40 onwards, Java has introduced new security features to check java certificates online. For more details, check this link [http://java.com/en/download/help/revocation_options.xml](http://java.com/en/download/help/revocation_options.xml).

---

**Note**

Perform the steps mentioned below only if the client system is not connected to Internet. Following steps must to be performed in the system where Operational Insight is browsed.

---

**To disable Java Certificate Check**

1. On the Windows **Start** menu, click **Settings > Control Panel**, and then click **Java (32-bit)** program.
   The **Java Control Panel** appears.
2. Click **Advanced** tab.
3. Select **Do not check (not recommended)**.
4. Click **OK**.

**Configuration changes for Trend with Event feature**

If you have configured integrated login before upgrading from Honeywell Operational Insight R360.1 to Honeywell Operational Insight R362.1, then refer to the parature KB 1211-2109 and make the changes accordingly.
Verify IE Settings

You may receive a Java login prompt while opening Operational Insight, if you have configured Integrated login. Perform the steps given below to verify the IE settings.

To verify the IE settings
1. Open Internet Explorer.
2. On the Tools menu, select Internet Options. The Internet Options window appears.
3. Click the Security tab.
4. Select the Internet icon.
5. Click Custom level. The Security Settings - Internet Zone window appears.
6. Under Logon, choose Automatic logon with current user name and password.
7. Click OK to close the Security Settings - Internet Zone window.
8. In the Security tab, select the Local Intranet icon. The Security Settings - Local Intranet Zone window appears.
9. Under Logon, choose Automatic logon with current user name and password.
10. Click OK to close the Security Settings - Local Intranet Zone window.
11. In the Security tab, select the Trusted Sites icon. The Security Settings - Trusted Sites Zone window appears.
12. Under Logon, choose Automatic logon with current user name and password.
13. Click OK to close the Security Settings - Trusted Sites Zone window.
14. Click Apply and then click OK to close the Internet Options window.

Launching ProcessNet for Integrated login
If integrated login is configured, use the url http://<server name>/ProcessNet to launch ProcessNet.

Configuring Trend with Events while running OI on a non default port
If OI is configured to run on a non default port, suffix the port number to the hostname in the following files. By default the hostname would be localhost, after adding the port number it would look like localhost:xyz (where xyz is the port number.)
You have to update the following files:

- **NetManage.exe.config**: Program Files
  \Matrikon\ProcessSuite\Processnet\DataServer\n
- **Web.config**: Program Files
  \Matrikon\ProcessSuite\Processnet\Web\OlIDataService\n
**Error: Could not commit the join position[0]**

You may receive an error *Could not commit the join position [0]* if you are using Internet Explorer 9, and if you are attempting to join two tables in NetQuery. To resolve this issue, install the Microsoft Security Update 2647516. For more information, refer to [http://support.microsoft.com/kb/2647516](http://support.microsoft.com/kb/2647516).

**Configure Netoffice**

If you are using netoffice on a client machine having windows 8 or 8.1 operating system, then netoffice add-in will not appear by default. Do the following to add the netoffice add-in for Excel.

1. Open Excel, click the **File** menu.
2. Select **Options**.
3. Select **Add-ins** from the **Excel Options** window.
4. Click **Go**.
   The **Add-ins** window appears.
5. Click **Browse**. Browse to the XLSTART folder in the office installation directory.
6. Select **netoffice.xla**, and then click **OK**.
   Netoffice appears in the add-ins list. Select Netoffice.
7. Click **OK**.
8. Restart Excel.

You may receive the following warning message when you open Microsoft Excel after installing netoffice.
Chapter 2: Installing Operational Insight

Click **Enable all code published by this publisher**. If this button is disabled, follow the instructions given below:

1. Open Excel. Click the Microsoft Office button, select **Excel Options**, and then click **Trust Center**.
2. Click **Trust Center Settings**.
3. Select Add-ins, and then select the **Require Application Add-ins to be signed by Trusted Publisher** check box.
4. Click **OK**.
5. Close and open Excel again.

**Configure IE settings for Netoffice**

Follow the instructions given below if you are using Internet Explorer 10 or Internet Explorer 11.

1. Open Internet Explorer.
2. On the **Tools** menu, click **Internet Options**.
3. Click the **Security** tab.
4. Under **Pop-up Blocker**, click **Settings**.
5. In the **Address of website to allow** box, type the OI IP address, and then click **Add**.
6. Click **Close**.
7. Click **Apply**, and then click **OK**.

Alternatively, you can also follow the instructions given below:

1. Open Internet Explorer.
2. On the **Tools** menu, click **Internet Options**.
3. Click the **Privacy** tab.
4. Select **Trusted Sites**, and then click **Sites**.
5. In the **Add this website to the zone** box, type the OI server, to the trusted sites, and then click **Add**.
6. Click **Close**.
7. Click **Apply**, and then click **OK**.
Netmanage configuration on client

If you are using netmanage on client and want to use the eventsource functionality then do the following:

Open the netmanage.exe.config file from the <Operational insight NetManage install dir>/ProcessNet/DataServer location.

8. Change “localhost” to point to Operational Insight server as shown below.

```xml
<client>
  <endpoint address="http://localhost/ProcessNet/ODIService/EventService.svc" binding="basicHttpBinding" bindingConfiguration="BasicHttpBinding_IEventService"
    contract="LinkToDotNet.ODIService.IEventService" name="BasicHttpBinding_IEventService"/>
  <endpoint binding="customBinding" bindingConfiguration="Web.HttpBinding_IEventService"
    contract="LinkToDotNet.ODIService.IEventService" name="Web.HttpBinding_IEventService"/>
  <endpoint address="http://localhost/ProcessNet/ODIService/EventService.svc/IIOIConfiguration"
    binding="basicHttpBinding" bindingConfiguration="Basic.HttpBinding_IIOIConfiguration"
    contract="LinkToDotNet.ODIService.IIOIConfiguration" name="Basic.HttpBinding_IIOIConfiguration"/>
</client>
```
Chapter 3: Upgrading From Previous Versions of Operational Insight

If you have a previous version of Operational Insight installed on your computer, you should ensure that you have a backup of your configuration files prior to installing the new version.

Upgrading to Operational Insight R362.1 is supported from versions 360.1 or above. If you have an earlier version of Operational Insight, you must first upgrade to a 360.1 or above version. For assistance and installation files for the intermediate upgrade, contact Product Support (see “Honeywell Product Support” on page 6).

Note
Operational Insight R362.1 requires Sun Java Virtual Machine version 1.8u51. While the setup wizard installs JVM 1.8 u51 on the server computer, any client computers must update the JVM manually to continue to use Operational Insight after the upgrade.

Pre-upgrade: Firebird

During the upgrade procedure, previous version Firebird will be uninstalled, and Firebird 2.5.3 is installed. To ensure you do not accidentally lose data, back-up any Firebird files that may be used by other programs.

If your system already has Firebird 2.5.3 or Firebird 2.5.2 installed, it is recommended that you take a back-up and then un-install it prior to beginning the Operational Insight R362.1 procedure.
Pre-upgrade: Processes and Services

Before installing Operational Insight, do all of the following:

1. Ensure there are no Windows Updates pending, and that no restart is required in the Windows taskbar.
2. Right-click in the Windows taskbar, and on the shortcut menu click Start Task Manager.
3. Right-click and then click End Process on all of the following processes:
   - NetObjectsSvc.exe (if NetObjects was previously installed)
   - PNScheduler.exe
   - PNServerSVC.exe
4. On the Windows Start menu, point to Settings, point to Control Panel, point to Administrative Tools, and then click Services.
   The Services control panel appears.
5. Right-click and then click Stop on all of the following Services:
   - Windows Update Service (on Windows Server 2008 Standard Edition R2 SP1 x64)
   - NetCalc Service
   - NetObjectsSvc (if NetObjects was previously installed)
   - ProcessNet Scheduler
   - ProcessNet Dataserver

Upgrade

To upgrade Operational Insight

1. For an upgrade of your existing components and installation of new standard components, ensure SQL Server is installed, and an instance has been created for use with NetObjects.
   If NetObjects is not required, you do not need an instance of SQL Server. See “To upgrade without adding new components” on page 34 for instructions on upgrading without adding NetObjects.
2. In the installation location double-click the setup.exe file.
   The setup wizard appears.
3. Select **Upgrade Operational Insight**, and then click **Next**.

4. Follow the remaining steps in the installation wizard to complete the upgrade.

5. When the NetObjects Setup opens, provide the required NetObjects credentials:
   a. On the **SQL Server Connection** page, do all of the following:
      i. Select **Set SQL Server connection details**.
      ii. Type the following in the related boxes:
         - **SQL Server Name**: the name of the SQL Server instance to be used with NetObjects.
         - **Database Name**: the name of the database in which to store the NetObjects data. By default, this is NetObjects.
         - **SA Name**: the name of the system administrator account for the database instance. By default, this is sa.
         - **SA Password**: the password for the system administrator account on the database instance.

   **Note**
   If your system had NetObjects installed prior to the upgrade, provide the SQL Server information used by the previous install.

   iii. Click **Next**.
Chapter 3: Upgrading From Previous Versions of Operational Insight

b On the NetObjects User Credentials page, do all of the following:
   i Assign a password to the following NetObjects accounts in the related boxes:
      • NOAdmin: this account is used by NetObjects Administrator accounts to connect to the NetObjects data source.
      • NOQuery: this account is used by all other NetObjects accounts to connect to the NetObjects data source.
      If your system had NetObjects installed prior to the upgrade, the NetObjects account information from the previous installation is added automatically.
   ii Click Next.

c On the Ready to Modify the Application page, click Next.

d Click Finish to close the NetObjects Setup.

6 The Password Manager Tool is displayed. You must enter new passwords for all the Users listed the tool. For more information on how to use the tool, refer to the “Password Manager Tool User Guide” provided in the Operational Insight R362.1 media.

7 Click OK in the installation complete dialog box to close the Installation Wizard.

8 If you had Integrated Logins configured prior to the upgrade, reconfigure the Integrated Logins settings. (See “Configuring Integrated Logins” of the Operational Insight Administrator’s Guide.)

9 If you had configured NetTrend reports in NetSchedule, do all of the following:
   a Open Operational Insight on the server computer using the NetSchedule user. (See “To configure NetSchedule” on page 17 for the steps to configure this user during a new install.)
      A Java Security Information prompt appears.
Java security warning

b Select **Always trust content from the publisher**, and then click **Run**.

c Restart the server computer.
Custom Upgrade

Operational Insight R362.1 now includes the NetObjects component by default, and will install it during the typical upgrade process. If you do not require NetObjects (or any other additional components), you can use the Custom option to upgrade your existing components.

To upgrade without adding new components

1. In the installation location double-click the `setup.exe` file. The setup wizard appears.

2. Select **Custom** and then click **Next**.
3. Follow the remaining steps in the upgrade wizard until the installation file list is displayed.
4. Click **Advanced**. The **Component List** appears.
5. Clear the check box for any unneeded components, and then click **OK**. For example, clear the **Honeywell NetObjects** check box if NetObjects is not required on this server.
6. Complete the upgrade as normal.
Chapter 4: Un-installing Operational Insight

Operational Insight can be un-installed using the setup wizard. You can also use the Add/Remove programs tool. If doing so, remove the components in the following order:

- Honeywell NetObjects
- Honeywell NetKPI
- Honeywell NetCalc
- Honeywell Operational Insight Components
- Honeywell Operational Insight

**To un-install Operational Insight**

1. In the installation location, double-click the `setup.exe` file. The Operational Insight setup wizard appears.

2. Select **Uninstall Operational Insight**, and then click **Next**.

3. Click **Uninstall** to remove Operational Insight.
Note
If you have modified the default SYSDBA password, then you are prompted to enter the password in the following screen.

Configure DataTransferTool
If netobjets is installed in Operation Insight server then before running the DataTransferTool, below mentioned modifications should be done in the configuration.xml during Backup as well as Restore.

1. Stop SQL server service.
   b. From the services console, stop SQL Server (SQLEXPRESS) and SQL Server Agent (SQLEXPRESS) services.

Alternatively, you can modify the configuration.xml file by adding the SQL Server service name and SQL Server Agent service name under the services tag.
You can find the service name by going to the service console. In the service console, right-click the service, and then click Properties. In the General tab, you will find the Service name.
The configuration.xml file should look similar to the one shown below:

```xml
<SERVICES NAME="SERVICES">
  <SERVICE>NetCalcService</SERVICE>
  <SERVICE>CalcEngineServer</SERVICE>
  <SERVICE>NetObjectsSvc</SERVICE>
  <SERVICE>svcPNScheduler</SERVICE>
  <SERVICE>PNServer</SERVICE>
  <SERVICE>firebirdServerDefaultInstance</SERVICE>
  <SERVICE>firebirdGuardianDefaultInstance</SERVICE>
  <SERVICE>SQLSERVERAGENT</SERVICE>
  <SERVICE>MSSQLSERVER</SERVICE>
</SERVICES>
```

2. Provide the complete path of the netobject DB in the Configuration.xml file. Below image shows the folder structure of NetObjects DB for "C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Data path."

The configuration.xml file should look similar to the one shown below:

```xml
<FOLDER NAME="C:\" BACKUPALLFILE="false" BACKUPALLSUBFOLDER="false">
  <FOLDER NAME="Program Files" BACKUPALLFILE="false" BACKUPALLSUBFOLDER="false">
    <FOLDER NAME="Microsoft SQL Server" BACKUPALLFILE="false" BACKUPALLSUBFOLDER="false">
      <FOLDER NAME="MSSQL.1" BACKUPALLFILE="false" BACKUPALLSUBFOLDER="false">
        <FOLDER NAME="Data" BACKUPALLFILE="false" BACKUPALLSUBFOLDER="false">
          <FILE>NetObjects.mdf</FILE>
          <FILE>NetObjects_log.LDF</FILE>
          </FOLDER>
        </FOLDER>
      </FOLDER>
    </FOLDER>
  </FOLDER>
</FOLDER>
```

**Backup and Restore Server Data**

Refer to see “Configure DataTransferTool” on page 38 before starting the backup and Restore option. You can backup the Operational Insight data and use the backed up data on a different machine.

**To backup Operational Insight data**

1. From the Operational Insight media, double-click the DataTransferTool folder.
2. Double-click the DataTransferTool.exe.
3. Select Backup.
4. Click the browse button and choose the location where you want to back up the files.
By default, the data transfer utility creates a folder called OperationalInsightBackup in the location that you have selected.

5. Click Backup.

To restore Operational Insight data
1. Copy the backed up folder to the machine where you have installed the latest copy of Operational Insight R362.1.
2. From the Operational Insight media, double-click the DataTransferTool folder.
3. Double-click the DataTransferTool.exe.
4. Select Restore.
5. Click the browse button and choose the location where the back up folder is saved.
6. Click Restore.

Backup and Restore Client Data

If you have installed NetManage on a client machine, and if you are using Eventsource feature of netmanage, then you have to manually back up the data.

To backup client files from the source machine
1. Backup the netmanage.exe.config by navigating to the <Operational insight install dir>/processnet/dataserver/netmanage.exe.config.
2. Update the tag mapping file, by following the instructions given below:
   a. Login to netmanage.
   b. Go to EventSource.
   c. Click Export tag mapping file.
   d. The file will be downloaded to <Operational Insight netmanage install directory>/processnet/dataserver/OITagmapping. Backup that file.

To restore client files on target machines
1. Replace the netmanage.exe.config file in the <Operational insight install dir>/processnet/dataserver/netmanage.exe.config location.
2. Copy the backed-up tag mapping file to the client machine, and perform the following steps:
   a. Login to netmanage.
   b. Go to EventSource.
   c. Click Import tag mapping file.
   d. Select the backed-up tag mapping file.
   e. Click OK.
Chapter 5: Licensing Operational Insight

Once the installation is complete, you must acquire and activate the license for your products. The License Wizard will open automatically after Operational Insight is installed. Cancelling the wizard at that time will begin your 30 day evaluation period. You can then license your products at a later time.

Ensure you have the lock selector and activation key before proceeding. These can be found inside the case of your software installation disc.

If you require assistance licensing your programs, contact Product Support, as described in see “Honeywell Product Support” on page 6.
Systems With Internet Access

If your products are installed on a computer with access to the Internet, you can run the complete licensing procedure from that computer. To ensure the license wizard functions as expected, make the following change the License wizard shortcut before attempting to license Operational Insight.

To adjust the License Wizard shortcut

1. On the Windows Start menu, point to Programs, point to Honeywell, point to Operational Insight, point to Utilities, right-click License Wizard, and select Properties. The shortcut properties dialog box appear.
2. Replace the target text with one of the following:
   - On an x86 system:
     
     "C:\Program Files\Matrikon\ProcessSuite\ProcessNet\DataServer\LicenseWizard.exe" -producttitle "Operational Insight" -email "support@matrikon.com" -ServerName "licensing.matrikon.com" -Port "80" -usehttps "0" -MTK_OI
   - On an x64 system:
     
     "C:\Program Files (x86)\Matrikon\ProcessSuite\ProcessNet\DataServer\LicenseWizard.exe" -producttitle "Operational Insight" -email "support@matrikon.com" -ServerName "licensing.matrikon.com" -Port "80" -usehttps "0" -MTK_OI
3. Click OK to close the shortcut properties dialog box.

To use the License Wizard

1. On the Windows Start menu, point to Programs, point to Honeywell, point to Operational Insight, point to Utilities, and then click License Wizard. The License Wizard wizard appears.

License Wizard
2 Do all of the following:
   a In the Lock Selector box, type the last two digits of the lock selector. This value is typically 14.
   b In the Activation Key boxes, type the activation key provided inside the case of your software installation disc.
3 Click Next.
The License Wizard will activate your licenses.
4 Once the License Summary appears, click Exit to close the License Wizard.
5 Restart the following services:
   - ProcessNet Dataserver
   - IIS

Systems Without Internet Access

If your products are installed on a computer without access to the Internet, you will have to generate a license file from another computer that is connected to the Internet.

To license a system that is not connected to the internet, you will need to complete all of the following:

1. To save the information required to generate the license file, see “To save a license summary file” on page 42.
2. To generate the license file using a computer connected to the internet, see “To generate a license file for a computer without internet access” on page 43.
3. To activate the license on the computer with your products installed, see “To activate the product license” on page 43.
To save a license summary file

1. On the computer with the products installed, on the Windows **Start** menu, point to **Programs**, point to **Honeywell**, point to **Operational Insight**, point to **Utilities**, and then click **License Wizard**. The **License Wizard** wizard appears.

   ![License Wizard](image)

   **License Wizard**

2. Do **all** of the following:
   
   a. In the **Lock Selector** box, type the last two digits of the lock selector. This value is typically **14**.
   
   b. In the **Activation Code** boxes, type the activation key provided inside the case of your software installation disc.

3. Click **Next**. The Summary Page appears.

   ![License Summary](image)

   **License Summary**
4 Click **Save**, and then save the text file to a location accessible from a computer with an internet connection. If you are generating the license file now, you can leave the License Summary window open.

**To generate a license file for a computer without internet access**

1. From a computer with an internet connection, open a Web browser and navigate to the **License Activation System**. http://licensing.matrikon.com/

Your 34-digit product activation key is on the inside of your software media. If you do not have this information please contact Matrikon Product Support for assistance.

[Activation Key] 

Obtain your lock code and computer name by running the Matrikon License Wizard on the computer with the Matrikon software installed. Copy it from the License Summary screen and then paste it here.

[Lock Code]

[Computer Name]

[Request License Key]

**License Activation System**

2. Do **all** of the following, using the information in the license summary file (see “To save a license summary file” on page 42):
   a. In the **Activation Key** boxes, type or paste the activation key.
   b. In the **Lock Code** box, type the or paste the lock code.
   c. In the **Computer Name** box, type or paste the name of the computer on which the product is installed.
   d. Click **Request License Key**.

The license will be generated.

3. Click **Save**, and then save the .MTK file to a location accessible from the computer with the products installed.

**To activate the product license**

1. On the computer with the products installed, if the License Summary page of the License Wizard is not open, follow the steps in “To save a license summary file” on page 42 to return to this wizard page.
Chapter 5: Licensing Operational Insight

License Summary

2  Do all of the following:
   a  Click **Browse**, and then navigate to the saved .MTK file.
   b  Click **Next**.
      The **License Wizard** will activate your licenses.

3  Once the License Summary appears, click **Exit** to close the **License Wizard**.

4  Restart the following services:
   •  ProcessNet Dataserver
   •  IIS
Index

I
installation
  system requirements, 1

L
license wizard, 40
  no internet, 41

S
server
  upgrading, 30
  system requirements, 1

U
uninstalling, 35
upgrading, 30
  server, 30